Overview

Using advanced features in Order Entry can streamline overall processing time, improve tracking of critical marketing information and eliminate the need to track information on spreadsheets.

Sample checkout, bundles and templates, order line grouping and email quote/order from print option make generating quotes and orders much more efficient. RFMS Mail and CMM remarks integration help facilitate improved internal communications right from the order.

Other advanced features provide an extra layer of information needed for more complex orders including baseline, split and additional commission, overages, certified payroll, billed not shipped and product driven order entry.

Reports provide additional information to support these activities and help you manage your data.

Outline

- Sample Check Out
- Using Bundles and Templates
- Additional Marketing Fields
- Quote/Order Line Grouping
- Locking Fields
- RFMS MAIL
- PDF History and Tracking
- CMM Integration
- Split & Additional Commissions
- Baseline
- Overages
- Product Driven Order Entry
- Billing Groups
- Providers Earnings History
- Billed Not Shipped
- Batch Printing
- Batch Job Costing
- Order Entry Reports
Quotes

Sample Checkout

Samples are entered on a quote just like a regular line. If you use barcoding, samples can be entered into your inventory and then scanned when entering the quote line. Or, you can simply enter a line and indicate that the line represents a sample. To check out a sample:

1. In the Quotes module, click on the green plus sign to insert a Quote.
2. Enter the Customer Information.
3. Fill in estimated install/delivery date, salesperson and customer type.
4. Insert line and choose the product and color the customer is most interested in.
5. Enter a quantity of one.
6. Click on Sample box.
7. The Sample Information box appears defaulting to the current date ‘Out’ date and a ‘Due’ date of two days later. These dates can be overwritten
8. Fill in the deposit amount, if any.
9. Click OK. Notice that the Sample line is now green and shows sample icon to the left of the line.
10. To return sample, double-click on the sample line, click on Sample Info and enter return date or simply unclick Sample and click on Return.

A report can be generated to see what samples have been checked out or what samples or due or both. Select parameters to include stores and salespeople desired, how to sort it and to run a page for each salesperson individually
Using Bundles and Templates

Bundles and Templates are grouping of either specific products and their matching pieces, or a generic listing, created in Products, to help you remember all of the steps in a process. Associated product templates are also called bundles. The product bundles may be downloaded directly from B2B or another product service, or you can build a product template in Products. When a product template is available, you are alerted in Order Entry.

Split or Combine Lines

Splitting Lines

To split an existing line, click on the Split Lines button that is located just below the customer order line area on the customer order.

This function is applicable for items and labor (product codes 03-99) and for roll goods (product codes 01 and 02), provided the roll line has not been assigned.

Before you split a line, lock the line total on the original line to prevent a change in the invoice total from rounding errors. This function may also be helpful when doing Partial Billings. You may divide original line entries and assign only those portions that you wish to bill for.
For example, one of your line entries may be for 200 yards of pad. When assigning there may be several different inventory records for the same pad, each with only a small amount available. If there are 40 yards on one record, 50 on another instead of adding new lines to the order, you can "split" the line.

Enter the quantity of for amount desired and the system will create a new line for with the identical information as the original. Those lines can then be assigned to the particular inventory records you wish to use.

If you split a line that is linked to a work order line, you must regenerate the work order line after the split. Area and notes on the work order line do not split.

Combining Customer Order Lines

The lines to be combined must be in a none status. Combines TAGGED lines. The lines must be the same style, product code, color. Lines can’t be combined unless they are exactly the same (not including area name). The areas for both the lines are put on the combined record.
Line Grouping

A Group tab has been added to the browse which will present the Lines in Line Group Order. If an Order Line is not specifically assigned to a group, it will be automatically assigned to “Line Group None”

When adding a new order line click on F8 to change the Group or to add another group.

The dialogue box will appear to select the Group desired to be associated with the line. If Default Product Codes are set up the Group will automatically be populated based on that mapping.
Also, note that below the browse, it shows the Line Group Description as well as the total of Lines for the highlighted group. Highlight a record and the Line Group Total will be displayed at the bottom of the line browse screen.

Printing with Sub Total (Line Grouping Feature)

Printing for Invoice / Acknowledgement, Estimate or Claims all have the same “Line Grouping” feature added. If the Lines for the document being printed do have Line Groups specified, Line Grouping will be enabled and will be set to the last grouping request for that type of document.
Set up Line Grouping

From the Group F8 click on the ADD button to generate a new Group Description and color.

The Group can be associated with Default Product Codes that will automatically populate the group when that product code is selected. In some cases a product code may have multiple surfaces it can be associated with (i.e. adhesives, cove base, underlayment) so those would be left blank so the user can associate them with the group that material is being used with.
A special print configuration is available on the website under the Program Download section. This must be loaded for the subtotal feature to print on quotes and orders.

**Ad Source, Contract Type, Order Type and Service Offering**
These fields allow users to specify more information on each order and allow you to run reports based on that information. These fields are user defined by their drop down choices. Titles of all except ad source can be changed from the Public Parameters. The choices are built from the File menu. Reports are currently in development but information is available now by printing the Material Analysis report to CSV file.
Locking Fields
Sold to, Sales Reps, Tax Status and Line Total/Unit Price can all be locked in parameters or by using the padlock icon. It is recommended that a password be set to unlock the padlock button.

Quote or Order LINE

Tax Status on Quote or Order

Sold To Section of Quote or Order

RFMS MAIL
From each module you have the ability to generate and send mail from one user to another within the RFMS Application. This system is basically used for tracking information on specific orders, inventory records, payables, etc. and all interoffice mails are permanently kept for that purpose. Only those users who are have logged into the RFMS application will be available for email. Once a user logs into the RFMS application, their user name will be available in the user list.
Sending a Message

To send a message associated with a particular record highlight the record and click on the mail button.

- From the select mail type box, click on Interoffice Mail. The New Message box will appear with that record referenced in the body of the interoffice mail message.

Once you have the new message box from either of these methods:
- You can type whatever you wish into the **Subject field**. It is best to make the subject something that gives the viewer a quick idea of the topic as it will show on the list of current messages. See figure below.
- You can set a **priority of Low, Normal and High** on the message.
- Select the **Require a Reply** option if desired and fill in date. If an Interoffice Mail is marked Reply required, then it cannot be deleted out of the Inbox until a reply has been sent. A require reply by date can also be added.
- **Tag the recipient(s)**. Tag one or more recipients.
- **Message Detail**: You can select an option or type text:
  - Recurring Note file which is shared by all RFMS Modules or
  - Import Remark which is specific to the CMM
  - Type a new message into the message block.
- When you have finished your message click the send button.
Receiving Messages

As of version 11.1, when a user has new mail, the message "You Have Mail!" will no longer pop up. Instead, the File Menu for Mail will switch to Bold Red text "Mail".

From the list of messages you can highlight the message to see, and the body will show in the preview screen. Inactive or completed items will be listed in gray. A mail record is considered inactive if it has been deleted. It is considered Completed if it has been read.

Browse Mail

Click the mail menu option on any RFMS screen. Inbox, Deleted Items or Sent Items can all be viewed from this same screen. Simply select the desired option in the top right hand corner. From the list of messages highlight the message to view, and the body will show in the preview screen below. Swap between “Mark as Read” or “Mark not Read”. Opening a message will automatically mark it as read.

Double clicking on the highlighted message allows viewing the full detail.

Messages can now be printed. Highlight the desired message, click the print button. The message will be printed to the default RFMS printer.
**Inbox/Sent**

- If a message requires a reply & a reply has not been sent a Green Question icon will display.
- A message will display in red text if a Reply is required, and no reply has been sent and the Reply By Date is either past due or due today. This is also the case on the CMM Workbench.
- High Priority messages will display a Red up Arrow icon.
- Deleted mail is in gray.
- Read but not deleted mail will be in blue.
  Any email that has not been read, regardless of color coding will be BOLD.
- For Interoffice Mail the **Reply by Date** is considered to be the **Due Date**.

**Deleted**

Deleting an inbox or sent message does not permanently delete the message, but puts it into the deleted list, then permanently delete it from the deleted list. A confirmation will be required first.

To un-delete a message, click the mark unread button. This will put the message back into the original list.

---

**Print Options - NEW Save as file or PDF History and Email**

The ability to email a quote or order directly from the print option screen has been added. It is now possible to automatically save the order as a PDF record in the default RFMS directory without any additional effort. There is also the option to save the document to PDF history where it can be referenced or reprinted at any time.

For Email PDF functionality to work properly the users email configuration must be set up in System Options/Users/Email Configuration.
PDF History

Users will easily be able to browse the PDF History and view each of the reports that have been printed for an order, quote, job etc... To see the pdf history, click the pdf button. If there are no pdf files attached the button will be gray. To view the actual record, click the view button. This will actually launch PDF document for all functionality available with the version installed on the workstation or server.

<table>
<thead>
<tr>
<th>Date Created</th>
<th>Time Created</th>
<th>Created By User</th>
<th>Created By Machine</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>04/09/13</td>
<td>11:19 AM</td>
<td>FINASSEY</td>
<td>RUBY-LAPTOP</td>
<td>Quote</td>
</tr>
</tbody>
</table>

Tracking History

Users will be able to browse Order Tracking information on every record insert made into Orders, Quotes and Bid Pro Estimates. Order Tracking Information will only be fully populated from the 10.6 install forward. Click the Order tracking button to see history.

To see the full history, check the show extended view box. This will show other orders, quotes and bids that are a source or destination related to this record.

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>User Name</th>
<th>Action Description</th>
<th>Source Name</th>
<th>Destination Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>03/17/13</td>
<td>9:33 AM</td>
<td>FINASSEY</td>
<td>CREATE NEW RECORD FROM SAL</td>
<td>RF-RE031713</td>
<td></td>
</tr>
<tr>
<td>03/17/13</td>
<td>2:55 PM</td>
<td>FINASSEY</td>
<td>CREATE NEW RECORD FROM SAL</td>
<td>RF-RE031713</td>
<td>RF-RE031713A</td>
</tr>
<tr>
<td>03/17/13</td>
<td>2:59 PM</td>
<td>FINASSEY</td>
<td>EXPORT QUOTE TO NEW ORDER</td>
<td>RF-RE031713A</td>
<td>RF-OF0000016</td>
</tr>
<tr>
<td>03/17/13</td>
<td>2:59 PM</td>
<td>FINASSEY</td>
<td>RELATE SALES LEAD TO ORDER</td>
<td>RF-SALE LEAD'S LAST NAM</td>
<td>RF-OF0000016</td>
</tr>
<tr>
<td>03/17/13</td>
<td>3:50 PM</td>
<td>FINASSEY</td>
<td>CREATE NEW RECORD FROM SAL</td>
<td>RF-RE031713</td>
<td>RF-RE0317138I-1</td>
</tr>
<tr>
<td>03/17/13</td>
<td>3:50 PM</td>
<td>FINASSEY</td>
<td>CREATE NEW RECORD FROM SAL</td>
<td>RF-RE031713</td>
<td>RF-RE0317138I-2</td>
</tr>
</tbody>
</table>
Order Entry

Baseline

This screen allows you to create a baseline for the highlighted customer order or the billing group that order is a part of. The baseline is a "snapshot" of the order at that moment in time. You may also print a report that compares a previous baseline with the order in its current status. You can use your baseline points to compare how a job is doing over a period of time and the final quantity, cost, selling price and gross profit percentage.

![Baseline Comparison Table]

<table>
<thead>
<tr>
<th>Style/Item Comparison</th>
<th>Baseline Qty</th>
<th>Actual Qty</th>
<th>Baseline Cost</th>
<th>Actual Cost</th>
<th>Baseline Sell</th>
<th>Actual Sell</th>
<th>Baseline GP</th>
<th>Actual GP</th>
<th>Variance GP</th>
</tr>
</thead>
<tbody>
<tr>
<td>502000% BILLING</td>
<td>2,000</td>
<td>2,000</td>
<td>0.00</td>
<td>0.00</td>
<td>3,400.00</td>
<td>3,400.00</td>
<td>0.00</td>
<td>0.00</td>
<td>15.00</td>
</tr>
<tr>
<td>1/2 REBOND PAD</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>44.50</td>
<td>44.50</td>
<td>0.00</td>
<td>0.00</td>
<td>35.12</td>
</tr>
<tr>
<td>1/2 REBOND PAD #</td>
<td>28.87</td>
<td>28.87</td>
<td>28.87</td>
<td>28.87</td>
<td>44.50</td>
<td>44.50</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>ADHESIVE</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>-100.00</td>
<td>-100.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>BEAUTIFUL EVENING</td>
<td>33.90</td>
<td>33.90</td>
<td>442.91</td>
<td>442.91</td>
<td>497.13</td>
<td>497.13</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>BELLAGIO/12K12 FL</td>
<td>100.00</td>
<td>100.00</td>
<td>355.00</td>
<td>355.00</td>
<td>1,000.00</td>
<td>1,000.00</td>
<td>65.50</td>
<td>65.50</td>
<td>0.00</td>
</tr>
<tr>
<td>CARPET INSTALLATION - STANDAL</td>
<td>25.97</td>
<td>25.97</td>
<td>106.65</td>
<td>106.65</td>
<td>177.85</td>
<td>177.85</td>
<td>40.03</td>
<td>40.03</td>
<td>0.00</td>
</tr>
<tr>
<td>Ceramic Installation/Resden</td>
<td>100.00</td>
<td>100.00</td>
<td>500.00</td>
<td>500.00</td>
<td>1,000.00</td>
<td>1,000.00</td>
<td>65.00</td>
<td>65.00</td>
<td>0.00</td>
</tr>
<tr>
<td>FABRIC MACHINE TIME</td>
<td>100.00</td>
<td>100.00</td>
<td>700.00</td>
<td>700.00</td>
<td>57.14</td>
<td>57.14</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>MEASURE FEE</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>-100.00</td>
<td>-100.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Variance</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Baseline VS Progress

<table>
<thead>
<tr>
<th></th>
<th>Baseline</th>
<th>Delivered</th>
<th>Undelivered</th>
<th>Current</th>
<th>Variance to Baseline</th>
<th>Payment Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract Total</td>
<td>7,275.23</td>
<td>2,575.23</td>
<td>35.40%</td>
<td>0.00</td>
<td>(4,700.00)</td>
<td>Grand Total 2,575.23</td>
</tr>
<tr>
<td>Change Orders</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00%</td>
<td>0.00</td>
<td>0.00</td>
<td>Change Orders 0.00</td>
</tr>
<tr>
<td>Grand Total</td>
<td>7,275.23</td>
<td>2,575.23</td>
<td>35.40%</td>
<td>0.00</td>
<td>(4,700.00)</td>
<td>Grand Total 2,575.23</td>
</tr>
<tr>
<td>Material Cost</td>
<td>2,221.29</td>
<td>(173.32)</td>
<td>-7.80%</td>
<td>0.00</td>
<td>(173.32)</td>
<td>Delivered 2,394.61</td>
</tr>
<tr>
<td>Service Cost</td>
<td>1,685.08</td>
<td>500.60</td>
<td>29.70%</td>
<td>0.00</td>
<td>500.60</td>
<td>Delivered 2,394.61</td>
</tr>
<tr>
<td>Overhead Margin</td>
<td>205.61</td>
<td>17.20</td>
<td>0.00%</td>
<td>0.00</td>
<td>188.41</td>
<td>Payments 2,394.61</td>
</tr>
<tr>
<td>Freight Cost</td>
<td>0.00</td>
<td>47.67</td>
<td>0.00%</td>
<td>47.67</td>
<td>(47.67)</td>
<td>Current Balance 2,394.61</td>
</tr>
<tr>
<td>Tax Cost</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00%</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Gross Profit</td>
<td>3,182.65</td>
<td>2,183.00</td>
<td>0.00%</td>
<td>2,183.00</td>
<td>979.65</td>
<td>979.65</td>
</tr>
<tr>
<td>Net Sale</td>
<td>7,275.23</td>
<td>2,575.23</td>
<td>35.40%</td>
<td>0.00</td>
<td>4,700.00</td>
<td>Project Balance 2,575.23</td>
</tr>
<tr>
<td>Gross Profit %</td>
<td>43.47%</td>
<td>54.77%</td>
<td>0.00%</td>
<td>54.77%</td>
<td>41.30%</td>
<td></td>
</tr>
</tbody>
</table>
Accounts Receivable – Due
This screen allows access to the Accounts Receivable information menu. Select the options desired to filter the customer information. This is a very efficient way to access an individual invoice for a particular receivable account.
CMM Integration

Clients with the Client Management module can add an alert, appointment, task, remark or letter for each order/customer in Order Entry. See Client Management for full instructions for this functionality.

The line highlighted above is a REMARK which any user can access in many places in RFMS to record information against a Customer or Record (Quote, Order etc). Think of them as permanent notes that can’t be accidentally cleared.
A remark requires a Remark Type which is available for searching on the Find or binoculars icon.

**Oversages**

How to add an overage for a customer order:

From Overage Screen click on ADD
Open the lineup that has the total from the ORIGINAL line.

Fill in the TOTAL price including the original amount what will bill charge to the Overage client.

The difference between what was on the ORIGINAL invoice.
Split Commissions

There is a private parameter to allow users to view and edit the split percentages on orders and quotes. Split commissions will affect sales reporting and commission reporting.

Additional Commissions

This feature allows you to pay extra or multiple commissions on any customer order. You may pay commissions to any customer, supplier, or worker you have in your RFMS database. These commission amounts are paid in addition to commissions paid to the sales representatives. By attaching the appropriate customer, supplier, or worker to the customer order and selecting the desired Commission Schedule, commissions are paid to that individual upon job cost.

To begin using the Additional Commission feature, you must first create new commission records. In order to do so, see the following instructions.

1. From Order Entry, click Utilities and select Commissions.
2. Click the Additional Commissions tab.
3. Click the Insert icon.
4. Select the appropriate name. Do so by clicking the button located directly to the right of the Name field.
5. You will be prompted to select between your Customer, Human Resources or Supplier files.
6. Next you will need to select a role. The role is a representation of the commission type. For example, you may want to pay commissions to an interior designer on a particular job. You would therefore enter “Designer” as a role.
7. Enter the appropriate phone numbers and e-mail address for the person you are paying commissions.
**Billing Groups**

New or existing customer orders can be linked together by Billing Groups. To create a new billing group or link orders together while highlighted on the new order or existing order and click the Invoice Billing Group icon. Fill in all the appropriate information (i.e. Billing Group Name, Finance Charge info, Retainage info.), then click Exit to save the new information.

**Billing Groups and Partial Billing**

Partial Billing of customer orders is accomplished by using Billing Groups. The overall concept works like this:

1. An order is entered for the entire job,
2. Material lines are split and exported to a new order(s)
3. A billing group is created that includes the original order and all new orders
4. Those new order(s) are job costed as they are completed
5. A billing notice is produced
6. The original is final billed when the entire job is completed.
Product Driven Order Entry

Product Driven Order Entry is a process that allows you to select products ONLY from the Product records when entering a new line. This feature is designed to allow you to optimize the usage of current inventory as well as reduce waste. Before beginning to use Order Entry in the Product Driven mode you must do the following: Activate the Public Parameter "Product Driven Order Entry" located in Parameters, Public Parameters, Product Drive OE. There may be certain products you wish to select directly from inventory. Highlight these products as exclusions. Set the appropriate information in the field called "Product Driven Order Entry Roll Pre-Select Values". This parameter will set a guideline for the system when choosing the appropriate roll inventory. This parameter requires a high value and a low value.
Batch Processing

Order Entry>File>Batch Processing or F12

Play Movie-Batch Processing Overview

Batch processing of picking tickets, picking sheets work orders (Including Custom Work orders) and cutting lines is now available.

The batch processing screens are similar to the customer orders browse screens. Orders are listed when picking tickets or work orders is selected and lines are listed when Cut lines is selected.

Tool bar

No editing is available from the tool bar.

- Use to find a specific range of records or a specific record. Alternately click the Find Tab on the left hand side. This find works the same as the ones for Customer Orders and Quotes. The list stays when switching between processes until the batch processing screen is closed.
- Reset the browse list to include all records.
- View highlighted order or line
- View lines on highlighted order.
- View notes on highlighted order or line
- Once records are tagged, use this button to start processing.

Cut Lines

Lines cut, (staged or delivered in errm) already will not be listed.
- Use the find option to decide which lines to display.
- Choose to include rolls, items and services.
- If ready to cut only is chosen only lines ready to cut will display.

If not chosen, Inventory Lines in “None”, “Gen PO”, “On Order” or “Reserved” Status will be displayed and the status will show in pink. These Lines cannot be tagged for processing. The intent here is alert the user that there are Lines in the target filter that are not ready in the event that these Lines were overlooked for ordering.
Picking Tickets and/or Picking Sheets

Orders available for processing are ones which are:

- Not delivered
- Either an Original order or a Claim
- Have order lines in a cut status.

Use the find option to decide which lines to process and format of Report

- If Include Rolls, Items and Services are all checked, the Picking Sheet only shows Roll and Item Inventory, but will post Rolls, Items and Services.
- If the user decides to only check Include Rolls, for a Roll Report, then only Order Lines with Rolls will be posted. Then for a second report only checks Include Items, then only Order Lines with Items will be posted. Services would be skipped entirely.
- Picking Tickets act the same always. So, if only Include Rolls is checked, but “Picking Tickets – Stage Orders” is used, only those Orders that have Roll Inventory to process will be selected, but all eligible Lines on the Order will be processed.

Work Orders

- Not delivered
- Either an Original order or a Claim
- Cut

Tagging Options

Records are selected to be processed by tagging.

- Left click on a record or highlight a record and click the tag/untag button or Right Click and then click tag/untag. Using tag all is usually done after using the find feature to narrow the list.
- Once records are selected by tagging, clicking the Printer Button process batches.

ptic Processing order is important!

Once a Line is Delivered / Staged, it cannot be picked up again unless the user sets the Line back to cut, so do not choose one of the selections to deliver lines if you want to run another picking document.
Providers History Reports
The Provider Earnings History report can be used to generate a report identifying labor paid in advance for jobs in progress and not yet job costed.

Certified Payroll
This feature allows you to keep an audit trail of certified rates placed on certain jobs from a government level. For certain governmental jobs a specific minimum rate is set. This helps to ensure that providers are being paid that rate by providing a comparison between the actual and certified amounts.

Price Change Report
This selection prints a report of all selling prices that were changed on a customer order using an authorization code within the specified time frame.

Soft Reserves Report
This prints a report of all soft reserves entered against inventory. Print this report periodically to be sure you don't have soft reserves that are expired.

Batch Print
This feature will allow you to post Invoices, Claims, Job Cost Sheets, Picking Tickets, Quotes and Work Orders to a “batch file” for printing. This “batch file” saves all stored documents until you are ready to print them. When printing any of the above mentioned documents, you will see an option labeled “Post to Batch”. Simply select this option and click the Print button.

The “Post to Batch” option will be available on each of the above mentioned documents’ Confirm Print screen.
Orders/Quotes Profit Report (from Sales Reports)
This report is useful to spot check quotes or orders to see abnormal profit percent or zero cost lines. This report is similar to the Quotes report in Order Entry, but not identical. For Quotes and Undelivered Orders the Gross Profit % default same as in OE. The default Overhead % is inherited from the Standard Overhead Margin, but you can edit it here.

My Commissions
This option was added in version 11.2 to the Order Entry Reports for a sales rep to print their preliminary commission report. It uses the same report routine as the preliminary commissions report from accounting, but is limited to the sales rep which is printing it.

For this report to be available the system must be set to in &gt;Utilities&gt;System Options&gt;System Wide&gt;General&gt; Password on entry only must be set to yes

Then the sales rep must have an associated password. Go to Utilities&gt;Maintain Passwords&gt;Add or Edit a Password&gt;Select a user name.

Enterprise Manager Users
Make sure the User Name is associated with the correct Sales Person (RFMS Name). Go to Enterprise Manager&gt;File&gt;User/Group/Role Management&gt;Insert or Edit

Report Options
The report menu option will then be visible when that password is entered on entry to the system.